
WinJammer™ Help Index

WinJammer™ is a Windows program which is used to manipulate MIDI data.    WinJammer allows you to 
record and playback songs, send and receive MIDI data, and edit MIDI events.    All files are stored using 
the standard MIDI file format.    This allows WinJammer to share MIDI files with other MIDI software 
packages.

WinJammer is not a free program, but is being distributed under the Shareware concept.    This allows 
you to examine the program, and to determine whether it is of worth to you.    If you find the program 
useful, and are going to keep using it after the evaluation period, you are under a moral obligation to 
register it.    The evaluation period for WinJammer is 30 days. Please review the help topic Registration for
more information.

This index contains a list of all Help topics available for WinJammer. For information on how to use Help, 
press F1 or choose Using Help from the Help menu.

Quick Start Quick start help for first time users.
Commands Information on a particular command.
Procedures Answers to "How do I..." questions.
Keys List of various keys used in WinJammer.
Registration How to Register WinJammer
Windows and MIDI Information about Windows and MIDI
Glossary Glossary of MIDI terms



Quick Start

Welcome to the Quick Start section.    Here we will try to get you up and running as fast as possible by 
describing how to play one of the sample songs that comes with Windows, CANYON.MID

Configuration

Before you can play a song, the Windows drivers for your hardware must be installed.    Refer to the 
Windows and MIDI section for detailed information on how to do this.

WinJammer must be also be told which devices you wish to use.    The MIDI Configure command is used 
to do this. 

A dialog box will be displayed showing available MIDI output ports.    Select the device driver that is 
appropriate for your equipment by highlighting it and clicking on Add or by double clicking on the driver 
name in the output box.    WinJammer requires the selection of an output port.    If you aren't going to 
record then you do not need to select an input port.    Click on Ok to finish configuration.

Important Note:    Sound    Blaster 1.0 and 1.5 owners.
The Sound Blaster 1.0 and 1.5 do not support simultaneous MIDI input and output.    It is possible to 
use the internal FM synthesizer for output and the MIDI port for input.    Alternately, select the Sound 
Blaster MIDI port for output, and select <none> for the input device.

Playing a Song

Select the File Open command through the menu, or by pressing the Ctrl+F12 key combination.    Using 
the dialog box displayed, select your Windows directory, usually C:\WINDOWS.    Select CANYON.MID, 
by highlighting it and clicking on OK, or by double clicking on the file name.    The song will be loaded into 
memory, and the main window will be updated to show a list of the tracks in the song.

2. Play the song.    This part is easy, simply click on the Play icon, or press the Spacebar, or press the P 
key on the keyboard.

Quick Overview of the Main Window

The sample songs that come with WinJammer, or with Windows, are voiced according to the General 
MIDI Specification.    This means they will play properly through the MIDI Mapper, assuming that you have
set up a mapping for your equipment.    Those of you with a Sound Blaster, Adlib or compatible 
equipment, already are set up according to the General MIDI Specification.

Right now you should be looking at the main WinJammer window.    In the Title bar you will see 
WinJammer - CANYON.MID.    WinJammer will always display the filename of the song that is currently 
open.    Below that is the Menu bar with the selectable menu items.    Below the Menu bar is the Toolbar.

The WinJammer Toolbar has the familiar Record, Play, Rewind and Fast Forward Buttons.    The Stop 
button will take the place of the Play button when a song is playing.    To the right of the Fast Forward 
button is the Event List icon.    This displays a window showing the data for the currently selected track.    
The next button is the Piano Roll.    This is much like the piano rolls that go into a player piano.    To the 
right of the Piano Roll icon are the Beat and Tempo scroll bars.    The Beat scroll bar shows the current 
position in the song, and the Tempo scroll bar shows the current tempo.    Next to the scroll bar is the Time
index.    The Time index shows how long the song has been playing.    To the right of the Time index is a 



question mark, the help button.    Pressing the help button will display this help file.    Pressing F1 at any 
time will display context sensitive help.

Below the Toolbar is the Main Track Window.    This window displays information about the currently 
loaded song, track by track.    Going from left to right the information displayed is Track Number, Track 
Name, Instrument Name, Channel, Patch Number, Number of Beats in the track, Number of Events in the
track and the Port Number.

For CANYON.MID, there should be two tracks listed: 0 and 1.    Track 0 contains no track name, no 
instrument name, uses multiple channels, uses more than one patch on that track, has 344 beats, 4526 
events and will be played on Port 1.    Select MIDI Configure to see which device is assigned as Port 1.

Adjusting the Song

Since we already have CANYON.MID open, we will perform some quick changes on it.

Let's break up the song into separate channels.    Select track 0 by highlighting 0 in the track number field.
Select Track on the menu bar, select the Split menu item.    A dialog box will be displayed that will allow 
you to split a track various ways.    We want to split by channel, which should already be selected.    Click 
on OK.    You will get 13 tracks, numbered from 0 to 12.

If you are using a Sound Blaster, Adlib or compatible, perform the following procedure.    Double click on 
the event number for each track that is using a channel between 1 and 10.    You will see the event 
number change to Mute.    The reason this is done is that the CANYON song is coded using a low/high 
duplicate scheme.    Since the tracks using the higher channels are a near duplicate of the lower 
channels, we mute them to avoid playing more notes than the Sound    Blaster, Adlib and compatibles are 
capable of handling.

Click on the Play Button in the Toolbar.    You should see the beat slider start to count and the time index 
change and hear the CANYON song.

To change other information on the Main window, stop play then highlight the item and press enter or 
double click on the item.      You are then able to edit or enter new data.

Information on Patch numbers is available with the manual that comes with your device or instrument.    
Select General MIDI to display a patch map of the General MIDI specification.

Information on using the Microsoft Windows MIDI Mapper can be found in your Windows user guide.

This is the end of the Quick Start tutorial.    WinJammer is a very rich MIDI sequencer and has loads of 
features.    Don't be afraid to experiment!



Commands

This index contains a list of the Help available on the various WinJammer Commands.    For information 
on how to use Help, press F1 or choose Using Help from the Help menu.

File Menu Create, Load or Save files.
Edit Menu Copy, Move or Delete tracks in the song.
Track Menu Perform changes on whole tracks.
MIDI Menu Control MIDI devices.
Song Menu Edit Song Parameters
Window Menu Control the windows.
Options Menu Customize WinJammer.



Procedures

This index contains a list of the Help available on the various WinJammer Procedures.    For information 
on how to use Help, press F1 or choose Using Help from the Help menu.

Copying a Track How to copy the contents of a track.
Deleting a Track How to delete a track.
Moving a Track Moving a track in the song.
Exiting Returning to Windows.
Recording Recording a track.
Playing How to play the song.
Selecting a Track How to select a track.
Switching Windows How to switch between active windows.
Opening Windows Starting one of the windows.
Closing Windows Destroying one of the windows.
Selecting Events How to select an event to edit.
Using the Toolbar Use of the Toolbar.
Saving Type 0 Files Creating a MIDI Format 0 file.



Windows Keys

The following keys may be used as shortcuts for various commands in the main menu.    These keys are 
active in all windows, except when the song is playing or recording.

F1 Help
F2 Open or Close the Event List window
F3 Open or Close the Piano Roll window
F4 Open or Close the Audition Patches window
Ctrl+F12 or Ctrl+O Open a new song
Shift+F12 or Ctrl+S Save the current song
F12 or Ctrl+A Save the song after asking for a file name
Ctrl+R Send Reset sequence to all MIDI devices
F6 Switch to the next window
Shift+F6 Switch to the previous window

The following sets of keys are only supported on some windows.    They are grouped by window.

Main Window Only

Ctrl+Z or Alt+Bksp Undo the previous track change
Ctrl+X or Shift+Del Move track into the paste buffer
Ctrl+C or Ctrl+Ins Copy the track into the paste buffer
Ctrl+V or Shift+Ins Insert the contents of the paste buffer
Del Delete the track from the song
Spacebar Start or Stop Play
P Start play
S Stop play or record
R Start recording
F Move to the end of the song
W Move to the start of the song
T Adjust the current tempo
B Adjust the starting position for playback
M Mute the current track
O Mute all tracks except current track

Event List & Piano Roll Windows

Enter Edit the current event
Del Delete the current event
Ins Insert a new event
D Change the note's duration
R Insert a rest before current note
C Make current note part of a chord
1 Turn current note into a whole note
2 Turn current note into a half note
3 Turn current note into a quarter note
4 Turn current note into a eighth note
5 Turn current note into a sixteenth note
6 Turn current note into a thirty-second note
7 Turn current note into a sixty-fourth note
Spacebar Start or Stop Play

Piano Roll Window Only



PgUp Move the current note up one octave
PgDn Move the current note down one octave
Up Move the current note up one semitone
Down Move the current note down one semitone
Tab Move to the next note in the track
Shift+Tab Move to the previous note in the track



Registration

As discussed in the index, WinJammer™ is being distributed as Shareware.    This allows you to evaluate
the program to see if it performs properly, before you are obligated to pay for it.    It does not allow you to 
"evaluate" the program forever - if you use it for more than 30 days, then you must register.

To register WinJammer send me a note and a cheque or money order for $50 US.    Please include in 
your note your name, mailing address, current version number and computer/MIDI setup.    The current 
version information is found in the Help About dialog box.    If you would like a copy mailed to you, please 
add an additional $5, and I will send you the most recent version available.    Please note that 
registration for WinJammer includes registration for WinJammer Player.

When I receive your cheque, I will send you a letter containing your personal registration code.    Use the 
File Register command to unlock the program.    If you have a CompuServe account, and include your 
CompuServe id, I will send the registration code immediately via CompuServe mail.    Otherwise I will 
have to send you an old fashioned letter.

I can be reached at:
Dan McKee
WinJammer Software Limited
69 Rancliffe Road
Oakville, Ontario
Canada
L6H 1B1

Please ensure that you use the correct postage.    It currently costs 40 cents to mail a letter from the US to
Canada.    A number of people have had their letters returned because of insufficient postage.

CompuServe Registration

If you have a CompuServe account, you can also register online.    Type GO SWREG at any CompuServe
! prompt.    Select product number 119.    The registration fee will automatically be added to your monthly 
CompuServe bill. You will receive mail from me on CompuServe, containing your registration information.  
You should have this within 24-48 hrs.    The most recent version of WinJammer can always be found in 
the MIDIFORUM on CompuServe, in library 11.

Software Excitement!

The good folks at Software Excitement! will also accept registrations for WinJammer.    They accept 
Visa/Mastercard, and will accept international orders.    If you want a copy of the program sent to you, they
can also do this for a nominal charge.

Software Excitement! can be reached via normal mail, phone or fax at:
Software Excitement! (Attn: Registrations)
6475 Crater Lake Highway
Central Point, OR 97502

Toll Free Phone: (800)444-5457
Fax Number: (503)826-8090
Non-Toll Free: (503)826-8082

Digital Music

If you are in the UK, you can register through my friends at Digital Music.    Registration through Digital 
Music costs £34 + VAT (£39.95).    They will accept orders by telephone, mail or FAX.    They will accept 



payment by Visa; Access or Mastercard; cheque, postal order or bankers draft.    All funds are in UK 
Pounds Sterling.    There is no additional charge for the use of credit cards.    Please allow up to seven (7) 
business days for a cheque to clear.

A diskette containing the most recent version of WinJammer can also be obtained from Digital Music for 
£3 + VAT (£3.53).    And telephone support is available directly through Digital Music for users who 
register through them.

Contact Digital Music at:
Digital Music
27 Leven Close
Chandlers Ford
Hants SO5 3SH
England

Phone: 0703 252131
FAX: 0703 270405

Prof Shareware

Prof Shareware in Denmark is now prepared to accept registrations for WinJammer.    They also have the 
most recent version of WinJammer available on their BBS.

To order through Prof Shareware, contact:
Prof Shareware
Benloese Skel 4 G
DK-4100 Ringsted

Phone: (+45) 53 61 90 42
FAX: (+45) 53 61 93 91
BBS: (+45) 57 67 17 47

MIDILIB.DLL

A substantial amount of the effort that went into WinJammer was actually spent developing MIDILIB.DLL -
the code that works with the Windows MIDI drivers.    If you are trying to develop a Windows program that 
uses a MIDI device, I may be able to help you out.

I am selling a developer's kit so that you can write your own Windows based MIDI programs.    This kit 
includes: printed documentation for the library, the needed include/library files, some example programs 
with source, a registered copy of WinJammer and limited distribution rights for MIDILIB.DLL.    The price 
for the kit is $100 US, and any registration fees already paid for WinJammer are deductible from this 
price.    The developer's kit is only available directly through WinJammer Software Ltd.

You will be able to distribute your programs through Shareware channels as long as you make a 
registered copy of your program available to me.    I will advertise your product with all of the Shareware 
MIDI programs that I produce.    You will have to acknowledge me as the author of MIDILIB.DLL, and 
place certain information in your program's About box.

If you are interested in distributing MIDILIB.DLL in a commercial product, a separate negotiated license is 
required.    Please give me a call to discuss this.    If necessary, I will customize a DLL for you.

WinCanvas

A Shareware editor/librarian using MIDILIB.DLL is now available.    This is a great program 



called WinCanvas, written by Roy Terry..    Roy's description of his program is:

WinCanvas, the first Windows-based Editor/Librarian for the Sound Canvas.    A true 
Windows 3.1 application using multiple spreadsheet-style windows for easy viewing &
editing of all Sound Canvas settings.    WinCanvas can send settings directly to the 
Sound Canvas, save settings to sysex files, or copy settings to the Clipboard for 
pasting into a Windows-based sequencer such as WinJammer.

Check it out!

Support (How to contact me)

There are a number of channels that you can use to contact me.    The preferred method is via 
CompuServe.

My CompuServe ID is 70742,2052.    A message there will reach me if sent via mail or if left in the 
MIDIFORUM.    I can also be reached through Internet as 70742.2052@compuserve.com.

I can also be reached by telephone at (416)842-3708.    Please try to call between the hours of 7 and 9 
PM, Eastern Time.    You can also FAX me at (416)842-2732 anytime.    If all else fails, you can always 
write me at the address above.



Spacebar

The Spacebar can be used to start and stop playback from the Event List, Piano Roll or Main window.

If a song is currently playing, pressing the Spacebar will cause it to stop.    If nothing is playing, the 
Spacebar will cause play to start.    For more information, see the topic Playing.



Mute

The current track can be muted at any time by pressing the M key.    This is often very useful when 
recording, or while voicing a song.

The O key can be used to mute a number of tracks.

The current track can also be muted using the Main window.    Simply highlight the number of events cell 
for the track to mute, and double click or press enter.



Solo

All tracks except the current track can be muted by pressing the O key.    This is very useful when 
recording or editing a song.

The M key can be used to mute a single track.



File Menu

The File menu includes commands that enable you to load or save files, or create a new song.

For more information about a File Menu command, select one of the following topics.

New Create a new song.
Open Loads a song file.
Save Saves the current song.
Save As Saves the song under a new name.
Merge Merges a song into current song.
Import Import an Adlib ROL file.
Import SysEx Import a System Exclusive file.
Exit Exits WinJammer.
Register Registers your copy of WinJammer.



Edit Menu

The Edit menu includes commands that enable you to copy, delete and move tracks within the song.

For more information about an Edit Menu command, select one of the following topics.

Undo Restores the previous contents of a track.
Cut Deletes track, and moves it to the paste buffer.
Copy Copies track to the paste buffer.
Paste Moves track from the paste buffer into the song.
Clear Clears a track of all events.
Delete Deletes a track.



Track Menu

The track menu includes a number of commands which perform global changes to an entire track.

For more information about a Track Menu command, select one of the following topics.

Change Channel Change the MIDI channel of events in a track.
Clear Section Delete events in a time range.
Filter Events Delete selected MIDI event types.
Filter Channel Delete MIDI events on some channels.
Information Edit track parameters, display track information.
Merge Merge events from two tracks into one.
Quantize Adjust timing of events.
Replicate Copy a section of a track.
Split Split a track into multiple tracks.
Transpose Transpose the notes in a track.
Transform Perform transformation on event values.



MIDI Menu

The MIDI menu includes items that control the way WinJammer responds to various MIDI events.

For more information about a MIDI Menu command, select one of the following topics.

Thru Determines whether MIDI events are echoed.
Record Filter Settings for filtering recorded midi data.
Metronome Configures the Metronome.
Reset Sends MIDI reset sequence on all channels.
Auto Reset Automatically send MIDI reset sequence on stop.
System Exclusive Send and Receive MIDI System Exclusive data.
Sys Ex Customize Customize System Exclusive request strings.
Advanced Advanced MIDI Settings.
Configure Configures the MIDI Device.



Song Menu

The Song menu is used to edit and set some options that effect the entire song.

For more information about a Song Menu command, select one of the following topics.

Timebase Sets the time base for a new song.
Song Key Sets the key signature for the song.
General MIDI Marks current song as being General MIDI



Window Menu

The Window menu controls which windows are displayed.

WinJammer contains several pop-up windows in addition to the main window.    The main window is the 
only window active when WinJammer is started, and shows a list of the tracks in the song. 

The Event List and Piano Roll windows are used to display or edit the events in a single track.    The 
Event List window displays the events in a text format, while the Piano Roll window displays MIDI Note 
events in a format similar to standard musical notation.

For more information about one of the WinJammer windows, select one of the following topics.

Event List Display or Edit MIDI Events in list format.
Piano Roll Display or Edit Note Events in Piano Roll format.
Audition Patches Shows Audition Patches

The Windows Menu is used to open or close one of the three WinJammer windows.    If a check mark is 
shown beside the window's name, then selecting that window will cause it to be closed.    If no check mark
is shown, the window will be opened.    Selecting Next Window or Previous Window allows you to cycle 
through each window that is open.

For further information about how to open and close the windows, select one of the following topics.

Switching Windows How to switch between active windows.
Opening Windows Starting one of the windows.
Closing Windows Destroying one of the windows.



Options Menu

The Options Menu occurs in three windows: Event List, Piano Roll and the Main window.    In each 
window, the menu contains a different set of options.

Most of these options are stored when you exit WinJammer so that next time you use WinJammer you do
not have to customize WinJammer again.

For more information about one of the Options Menu commands, select one of the following topics.

ROL Pitch Wheel Enable MIDI Pitch Wheel events in ROL files.
ROL Save Patches Save instrument mapping in ROL files.
Preferences Set preferences for WinJammer.
Relative Control the interpretation of time changes.
Velocity Display or hide the velocity scale.
Dashed Lines Display or hide dashed staff lines.
Clef Switches Display selected clef staff lines.
Sound Event Sound events as they are selected.



Copying a Track

In order to duplicate the contents of a track, the following steps must be performed.

1. Select the track you would like to copy by selecting it in the main window.    See Selecting a Track for 
more information.

2. Perform an Edit Copy command (key: Ctrl+Ins) to copy the track into the paste buffer.

3. Select the location to insert the new copy of the track.    This is done by selecting the track that the new 
track should be inserted before.

4. Perform an Edit Paste command (key: Shift+Ins) to insert the track into the song.

If another copy of the track is desired, repeat steps 3 and 4.

If you only want to copy a section of a track, see the Track Replicate command.



Deleting a Track

In order to delete a track perform the following steps.

1. Select the track you would like to delete.    See Selecting a Track for more information.

2. Perform an Edit Delete command (key: Del) to delete the track from the song.



Moving a Track

In order to move a track to another position in the song, perform the following steps.

1. Select the track you would like to move.    See Selecting a Track for more information.

2. Perform an Edit Cut command (key: Shift+Del) to delete the track and place it into the paste buffer.

3. Select the location to insert the track, remembering that the track will be inserted before the selected 
track.

4. Perform an Edit Paste command (key: Shift+Ins) to insert the track back into the song.



Exiting

To exit WinJammer and return to Windows, choose either Close from the main window's system menu or 
Exit from the File menu.    You can also close WinJammer by pressing the Alt+F4 key combination.

If you have not saved your last set of changes, WinJammer will ask you if you want to save them before 
exiting.



Recording

The following steps are required to record a track.

1. Select the track in the song to record.    If the track chosen is not empty, the recorded track will replace 
it in the song.

2. Press the Record button to start recording.

3. Press the Stop button when recording is finished.

If you inadvertently record over a track which you did not want to lose, the Edit Undo command (key: 
Alt+Bksp) will restore the original track.    If you also want to keep your newly recorded track, use the Edit
Copy (key: Ctrl+Ins) or Edit Cut command (key: Shift+Del) to copy the recorded track into the paste 
buffer before restoring the original track.

Advanced MIDI Options.

If you are recording from another MIDI Sequencer or computer, then the Wait for MIDI Start and MIDI 
Clock switches will prove to be useful.    The MIDI Clock switch specifies that the tempo is to be taken 
from the remote MIDI device, rather than using the internal clock.    The Wait for MIDI Start switch allows 
the remote device to start and stop the recording.    For more information, see the MIDI Advanced 
command.



Playing

A song is played using the toolbar on the main window.

Play is started by pressing the Play button, or pressing P.    Play can also be started by using the 
Spacebar in the Piano Roll, Event List or Main windows.

While the song is running, the Main window is updated to show the elapsed time in seconds and the 
current beat number.    As tempo changes or patch changes are encountered, these are also displayed.

The tempo of the song can be changed while it's playing using the tempo scroll bar.



Selecting a Track

The current track is used in the two edit windows, and all of the commands in the Track menu.    To 
change the current track, perform the following steps.

Using the Keyboard

1. Switch to the main window by pressing F6 one or more times.

2. Use the cursor Up/Down keys to change the selected track.

Using the Mouse

1. Switch to the desired track by clicking on it in the main window.

See Switching Windows for more information on how to switch to the main window.



Switching Windows

With the multiple windows approach used by WinJammer, a method of rapidly switching between active 
windows is needed.

Using a Mouse

To switch to another window using the mouse, simply click somewhere on the window you wish to switch 
to.    If the window is not active, you can start it using the Window menu of the main window.

You can also switch windows by clicking on an icon on the Toolbar.    These icons open the window if it is 
closed, close the window if it is the active window and switch to the window if it is not the active window.

Using the Keyboard

Two keys have been provided which will cycle through the active windows.    The F6 key switches to the 
next window, while the Shift+F6 key will switch to the previous window.    The order of the windows is: 
Notes List, Piano Roll, Audition Patches and Main Window.

The window menu (or short cut key) may also be used to switch control.    These commands open the 
window if it is closed, close the window if it is the active window and switch to the window if it is not the 
active window.



Opening and Closing Windows

The various windows are opened and closed in three ways.    You can use the Window menu of the main 
window, various short cut keys or the icons on the toolbar.

Using the Mouse

Use the mouse to execute the correct command from the Window menu of the main window.    If the 
window is closed, it will be opened.    If it's open and the active window, it will be closed.    If it's open and 
not the active window, it will be made the active window.

You can also click on the appropriate icon on the toolbar.    This performs the same way as is described 
above.    The various icons on the toolbar are listed below along with the short cut keys.

Using the Keyboard

Each window has been assigned a function key which is used to open, close or switch to the window.    
The short cut keys are listed below.

F2 Event List Window

F3 Piano Roll Window

F4 Audition Patches Window



Selecting an Event

To edit or delete an event from a track, you must first select it in either the Event List window or Piano Roll
window.    This can be done with either the keyboard or the mouse.

Event List Window

This window behaves like a normal Windows list box.    Select an event by clicking on it with the mouse, or
using the cursor keys to move your selection.    The event can then be edited by double clicking or using 
the Enter key.    The event can be deleted using the Del key.

Piano Roll Window

To select a note in this window with the mouse, simply click on the desired note.    With the keyboard, use 
the Tab/Shift+Tab keys to move to the next or previous note.    The note can be edited by double clicking 
or using the Enter key.    The event can be deleted using the Del key.



Using the Toolbar

If you have a mouse, the toolbar is a handy short cut to using the menus, just as short cut keys provide 
abbreviation for keyboard users.    In order to use the toolbar you must have a mouse.    The various 
controls on the toolbar are described below.

Record & Play

This icon is used to start recording on the current track.    This is equivalent to pressing the R key on the 
main window.    See the Recording topic for more information.

This icon starts playing the song.    This can also be done using the P key on the main window, or by 
pressing the Spacebar.    See the Playing topic for more information.

This icon replaces the play icon while playing or recording.    Pressing it will stop play, as will the 
Spacebar.

Rewind & Fast Forward

This icon rewinds the current song position back to the last position that playing started or back to the 
start of the song.    If pressed while playing or recording, this will stop play before rewinding.    This can 
also be done using the W key on the main window, or through the use of the Beat scroll bar on the 
toolbar.

This icon fast forwards the current song position to the last place that playing started or the end of the 
song.    This can also be done using the F key on the main window, or through the use of the Beat scroll 
bar on the toolbar.

During playback, the fast forward button can be used to double or quadruple the current tempo.    Each 
time it is pressed, it will cycle through double tempo, quadruple tempo and normal tempo.

Event List and Piano Roll

The next two icons start up, shut down and switch to any one of the three pop-up windows that are used 
for track editing and playing.

This icon is used to start up, switch to or close down the Event List window.    This window is used to edit 
a track's data in a list format.



The Piano Roll window is started, switched to or closed down with this icon.    It is used to edit a track's 
note data in a format similar to standard musical notation.

Beat

The current beat number is displayed while playing or recording.    Whenever play is started, it is started at
the current beat number.    The scroll bar can be used to change the starting point as well.    The B key 
can be used to move the focus to the scroll bar, or the mouse can be used to move the scroll position.    
The rewind and fast forward buttons are also used to control the starting position for playback.

Tempo

The current tempo is displayed as a number of beats per minute and on the scroll bar.    When playing, all 
tempo changes are reflected here.    The T key can be used to move to the tempo scroll bar.    The tempo 
can be changed while the song is playing using the scroll bar.

Help

This icon is used to start up the help system that you are using to view this file.    It is equivalent to the 
Help Index menu item or the F1 key.



Saving Type 0 Files

In order for a song to be saved as a type 0 file, there must be only one track in the song.    If there is only 
one track in the song, WinJammer will save the file as a type zero file.

Follow the following steps to create a type 0 file.

1. Merge all of the tracks in the song into a single track in track number zero.    This can be easily done 
using the Track Merge command.

2. Delete all tracks other than track number zero.    This is done by pressing highlighting the track to 
delete and pressing the Del key.    See the Edit Delete command for more details.

3. Save the song using the File Save or File Save As command.



File New Command

The File New command is used to clear the current song from memory.    It deletes all tracks, and 
reinitializes the system to its start up state.

If you have not saved the last changes you made to the current file, WinJammer will ask you if you would 
like to save them before clearing the song.

After clearing the song from memory, before any recording is done, you should always set an initial tempo
and time signature in track zero.    See Event List Window and Recording for details.

Short Cut Key: Ctrl+N



File Open Command

The File Open command is used to load a song from disk.    It replaces the current song in memory.

If you have not saved the last changes you made to the current file, WinJammer ask you if you would like 
to save your changes before loading the new song.

This command will load standard MIDI files from a number of sequencers as well as files saved from 
WinJammer.    For more details on the supported files, see MIDI File Format.

Short Cut Key: Ctrl+F12



File Save Command

The File Save command saves the current song using the current file name.    If there is no current file 
name, the File Save command is the same as the File Save As command.    If a song was previously 
named using the File Save As command or if the file was loaded using the File Open command, then the 
file on disk is overwritten by the song.

Files created by WinJammer can be loaded by many other MIDI software packages.    For information on 
the file format used, see MIDI File Format.

Files are saved as MIDI format 1 files unless only one track exists in the song.    When only one track is in 
the song, the file is saved as a format 0 file instead.    See Saving Type 0 Files for more details on how to 
create a type 0 file.

Short Cut Key: Shift+F12



File Save As Command

The File Save As command saves the current song, after prompting for a file name.    If the entered file 
name exists, WinJammer will prompt before overwriting the file.

Files created by WinJammer can be loaded by many other MIDI software packages.    For information on 
the file format used, see MIDI File Format

Files are saved as MIDI format 1 files unless only one track exists in the song.    When only one track is in 
the song, the file is saved as a format 0 file instead.    See Saving Type 0 Files for more details on how to 
create a type 0 file.

Short Cut Key: F12



File Merge Command

The File Merge command is used to load a song into memory without losing the contents of memory.    
This can be used to merge two songs together.

Each track from the merged file is added as a new track.    If the timebase of the merged song is different 
from the current song in memory, the merged song's timebase is adjusted to match.    This means that you
should make sure that the current song's timebase is reasonable before performing the merge.    Use the 
Song Timebase command to do this.

Once the song has been merged into memory, you should edit and/or merge the tempo and time 
signature events into track zero using the Track Merge command.

The song key of the merged file is ignored.    The two songs are not adjusted to make sure they are in the 
same key signature.    You will have to do this yourself, using the Track Transpose command.



File Import Command

The File Import command is used to import an Adlib ROL file into memory.    A dialog box is displayed 
allowing you to select the file to load.    Once a file is selected, the ROL file is read into memory.

A second dialog box is displayed after the song has been loaded.    Using this dialog box, you can select 
appropriate MIDI patch numbers to match the instruments in the ROL file.    Once you assign patch 
numbers to all ROL instruments, all of the patch numbers will be added to the converted file.    If the ROL 
Save Patches switch is on, the patch assignments will be saved for the next time you wish to import a file.

After the import operation is complete, track zero will contain time signature and tempo change events 
only.    The track name of this track will be the same as the ROL file name.

Each track converted will be named after the first instrument found in the track.    The second instrument 
found will be used as the instrument name.    The output track is monophonic, and is assigned to channel 
one.    The only possible events that will be produced are note events, pitch wheel changes and patch 
changes.    The production of pitch wheel changes is controlled by the ROL Pitch Wheel switch on the 
options menu.    Since the track volume commands from the ROL file are translated into velocity, you may 
need to adjust the velocity scale of the tracks using the Track Transform command.    Finally, you should 
assign appropriate channels to the tracks using the Track Change Channel command.



File Import Sysex Command

The File Import Sysex command is used to load a file containing raw system exclusive events into a new 
track.    The loaded file is in the format used by the MIDI System Exclusive command.    Each system 
exclusive event is placed into the track, with a one tick time offset from the previous event.    Use the 
Track Transform command to increase the time between the events.



File Exit Command

The File Exit command will terminate WinJammer, and return to Windows.    If the last changes to the 
current file have not been saved, WinJammer will ask if you would like to save them before exiting.

Short Cut Key: Alt+F4



File Register Command

The File Register command is used to register your copy of WinJammer.    Once registered, the reminder 
dialog will no longer appear.    The track name field will also be able to be entered and saved, and the 
About box will display the registration information.

To register the program, you must carefully enter the registration information.    Please take care to enter 
the three fields exactly as I sent them to you, or the registration will be rejected.

For more information on registration, including the cost and how to do it, see the Registration topic.



Edit Undo Command

The Edit Undo command is used to undo the previous operation on a track.

All commands which cause a track to be changed will copy the original track into the undo buffer before 
making any changes.

The Edit Undo command will switch the contents of the undo buffer and the original track.    A second Edit 
Undo command will undo the previous undo.

Short Cut Key: Ctrl+Z



Edit Cut Command

The Edit Cut command copies the contents of the current track into the Windows Clipboard.    The 
previous contents of the clipboard are lost.    The track is then removed from the song.

This command can not be reversed using the Edit Undo command, however the Edit Paste command can
be used to insert the track back into the song.

Short Cut Key: Ctrl+X



Edit Copy Command

The Edit Copy command copies the contents of the current track into the Windows Clipboard.    The 
previous contents of the clipboard are lost.

This command can not be reversed.

Short Cut Key: Ctrl+C



Edit Paste Command

The Edit Paste command inserts the contents of the Windows Clipboard into the song before the current 
track.    All tracks from the current track to the last track are shifted down to make room for the new track.

A track is placed into the clipboard using either the Edit Copy or Edit Cut commands.

Short Cut Key: Ctrl+V



Edit Clear Command

The Edit Clear command will clear the contents of the track.    It removes all events from the track.    The 
original track is not available for an Edit Paste operation, however it can be recovered using the Edit Undo
command.



Edit Delete Command

The Edit Delete command will delete the contents of the track, without copying the track into the paste 
buffer.    The deleted track is not available for an Edit Paste operation

This command can not be reversed.

Short Cut Key: Del



Track Change Channel Command

The Change Channel command will change the channel number of selected events in a track.

A dialog box is displayed prompting for a channel range and the new channel number.    All MIDI events in
the track which have a channel number in the entered range will have their channel number set to the 
new value.

For example, assume there were two events in the track:
1:000 Note On 3 C 5 64 0:059
2:000 Note On 4 E 6 64 0:119

If a change channel command were carried out, selecting a range of 4 to 16, with a new channel of 1, the 
following would result:

1:000 Note On 3 C 5 64 0:059
2:000 Note On 1 E 6 64 0:119

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track.



Track Clear Section Command

The Clear Section command is used to delete all events in a range from a track.

A dialog box is displayed, allowing the entry of the start and ending times.    These times are inclusive, 
that is if a starting time of 1:000 is specified then an event with a time of 1:000 will be deleted.    This 
command will not effect any events outside of the specified time range.    Events starting after the end of 
the range will not have their starting times changed.

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track.



Track Filter Events Command

The Filter Events command is used to delete certain MIDI events from a track.

A dialog box is displayed, which is used to select which event types are to be deleted from the track.    
Selecting an event causes an "x" to be displayed in the check box, which will cause any events of this 
type to be deleted from the track.

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track.



Track Filter Channel Command

The Filter Channel command is used to delete all MIDI events in a channel range from a track.

A dialog box is displayed, which is used to select the range of channel numbers to delete.    All events with
a channel number in the specified range will be deleted.

Non MIDI events such as tempo and time signature events will never be deleted.

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track to its original value.



Track Information Command

The Track Information command is used to edit temporary information for a track, as well as display 
useful track information.

The following is a list of the fields that can be modified using this command.

Velocity Adjust by is a quantity to be added to the velocity of all MIDI Note On events.    This is often 
used to control the volume of the notes.    Negative adjustments are supported by simply entering a 
negative value.    Velocity adjustments are not saved, however the Track Transform command can be 
used to perform a permanent velocity adjustment.

Semitones to Transpose is used to transpose the track during playback.    Negative transpose amounts 
can also be used.    The transpose amount is not saved.    See the Track Transpose command for a 
permanent transpose command.

Information Displayed

If all events in the track occur on the same MIDI channel, that channel number is displayed.    If more than
one channel is used, the message "MIDI Events on Multiple Channels" is displayed instead.    If there are 
no MIDI events in the track, the message "No MIDI Events" is displayed.

The total track time length is displayed, along with the number of events in the track and the number of 
bytes required to hold the track.

The maximum number of simultaneous notes that are on at any given time is displayed.    If only one note 
is on at a time, the message is "Monophonic Track".    If no note events are found in the track the 
message will be "No Notes in Track".

The range of note events is displayed.    This is often useful when converting drum tracks between 
different drum machines.    The note range is shown by both note name and decimal MIDI note number.    
The octave number displayed can be adjusted using the Options Preferences command.

If a MIDI Program Change event occurs in the track, the selected patch number will be displayed.    If 
multiple patches are used, a message will indicate this as well.    The patch base can be adjusted using 
the Options Preferences command.



Track Merge Command

The Track Merge command is used to combine the contents of two tracks into one.    All events from both 
tracks are placed into the destination track, in the appropriate order.

Since only the destination track is changed, the Edit Undo command will restore the previous contents of 
the destination track.



Track Quantize Command

The Track Quantize command is used to globally alter the timing of all events in a track.

The starting time for all events in the track will be adjusted so that they start on a time which is an even 
multiple of the entered time.

The note lengths can also be quantized if desired.    The three possible actions that can be performed on 
the note lengths are:

Unaffected do not adjust any note lengths
Aligned quantize note lengths
Equal set all lengths to the quantization time

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track to its original value.

For example, assume that the track contained the following:
0:118 Note On 3 C 5 64 0:073
1:112 Note On 3 E 6 65 1:010
2:049 Note On 3 F 5 40 0:080

Quantization with lengths Unaffected and a Time Interval of 60 (eighth note) will produce:
1:000 Note On 3 C 5 64 0:073
2:000 Note On 3 E 6 65 1:010
2:060 Note On 3 F 5 40 0:080

With lengths Aligned, result would be:
1:000 Note On 3 C 5 64 0:059
2:000 Note On 3 E 6 65 0:119
2:060 Note On 3 F 5 40 0:059

With lengths Equal, resulting track is:
0:118 Note On 3 C 5 64 0:059
1:112 Note On 3 E 6 65 0:059
2:049 Note On 3 F 5 40 0:059



Track Replicate Command

The Replicate command is used to make one or more copies of a section of a track.

A dialog box is displayed, which is used to select a range to copy from, a starting time for the first copy 
and the number of times to copy the section.

All events in the source range are copied.    The times specified are inclusive, that is if an event starts at 
one of the boundary times then it will be included in the copy.

The starting time entered is the time that the "from" time is mapped to.    When more than one copy of the 
section is made, the starting time for the new copy is the previous starting time plus the length of the 
source range.

For example, suppose the original track contained the following:
1:000 Note On 3 C 5 64 0:073
2:000 Note On 3 E 6 65 1:010
2:060 Note On 3 F 5 40 0:080

If a copy was made with source from 2:00 to 3:00, with a starting time of 4:00 and two copies are made, 
then the following track will result:

1:000 Note On 3 C 5 64 0:073
2:000 Note On 3 E 6 65 1:010
2:060 Note On 3 F 5 40 0:080
4:000 Note On 3 E 6 65 1:010
4:060 Note On 3 F 5 40 0:080
5:000 Note On 3 E 6 65 1:010
5:060 Note On 3 F 5 40 0:080

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track.



Track Split Command

The Track Split command is used to split a track into one or more tracks.    There are four different ways 
that a track can be split.

Channel: specifies that each output track should only contain events on one MIDI channel.    If the source 
track also contains non-MIDI events such as a tempo change, an additional track will be created for these
non-MIDI events.

Event: each different event type will be split into a separate track.    For instance a track containing note 
events and program changes would be split into two tracks.

Individual Note: each output track will only contain one note's events.    This would primarily be used 
when converting a song from one drum machine to another.    This will in general create a large number of
tracks.

At: performs a split at a specified note.    The source track will be split into two tracks.

Since only the source track is changed, the Edit Undo command will only restore the previous contents of 
it.    The split tracks must then be manually deleted.



Track Transpose Command

The Track Transpose command is used to transpose all note events in the track.    There are two types of 
transpositions supported.

A Normal Transposition is performed by adding a number of semitones to each note.    This corresponds 
to a change in the key signature of the track.    To transpose up one octave, you must transpose 12 
semitones.    To transpose down one octave, use -12 instead.

In Key transposition is a special type of transposition, where the track is moved up or down without 
changing the key of the track.    For example if a standard C scale is moved up one tone, you get a C 
scale from D to D.

When performing an In Key transposition, you must enter the current key of the song and the number of 
tones to transpose.    A transposition of 7 tones is equivalent to a normal transpose of one octave.

Suggestion: A song written in a major key can be converted into a minor key by performing an In Key 
transpose of -2 tones, followed by a normal transpose of 3 semitones.

The Track Information command can be used to temporarily transpose a track for playback.

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track to its original value.



Track Transform Command

The Track Transform command is used to transform all events in a track according to the formula:
new = ( ( old + add ) * mult ) / div

In other words, the original data has an amount added to it (which may be negative).    The result is 
multiplied by a number, and this result is divided by another amount.    The resulting value is range 
checked to ensure it is valid, and this result becomes the new value.

The event data to be transformed can be any of the following: Note Velocity, Key Pressure, Control 
Change, Channel Pressure, Pitch Wheel, Song Tempo, Event Start Time or Note Length.

This command can do some very powerful things to your data, such as: adjusting the velocity of a track, 
evenly adjusting the tempo of a song, quantizing events etc.

Consider the following problem.    You have a track which has velocities between 0 and 127 which you 
want to adjust into the range 0 to 100.    You could adjust these by adding -27 (multiply by 1, divide by 1), 
which would probably make some notes too soft.    A better way would be to add zero, multiply by 100 and
divide by 127.    This will evenly re-map the velocities.

A similar process can be used to adjust a song's tempo.    If there are a few tempo events, you might find 
it easier to edit them.    If there are a large number of tempo events, and you want to speed up the tempo 
by 5% as an example, then add zero, multiply by 105 and divide by 100.



MIDI Thru Switch

This switch determines whether MIDI events received are echoed.    If this switch is on (checked), all MIDI
events received are echoed to the currently selected output device.    This effectively changes the MIDI 
Out ports into MIDI Thru ports.

System Exclusive messages are never echoed.



MIDI Record Filter Command

This command is used to determine which events are to be recorded, and which events are to be ignored.
The dialog which appears allows you to select the event types which are to be recorded.    To record an 
event type, make sure a cross appears in the checkbox.

This command only has an effect while recording.    It does not effect which events are played, nor does it 
have any effect on the echoed events if the MIDI Thru switch is enabled.



MIDI Metronome Command

This command is used to customize the MIDI metronome for your equipment.

The dialog box displayed allows you to select two notes to be used for the metronome.    It also allows you
to turn the metronome on or off.

In Accented mode two notes are used for the metronome.    The note labeled "First Note" is sent as the 
first beat in a measure, while the other note is sent for the remaining beats in the measure.

In On mode the single note in the "Other Beats" box is sent on each beat.

The Record Only switch is used to turn the metronome off during playback.    When this switch is on, the 
metronome will only be heard while recording.

The Metronome can also be controlled on the Audition Patches window.



MIDI Reset Command

This command causes a MIDI reset sequence to be transmitted on all channels.    The reset sequence is 
as follows:

Bx 7B 00 ;all notes all
Bx 01 00 ;modulation wheel to zero
Bx 07 7F ;volume to max (127)
Bx 40 00 ;sustain pedal off
Ex 00 40 ;centre pitch wheel

The MIDI Auto Reset switch can be used to force a reset sequence to be sent whenever play or record is 
stopped.

Short Cut Key: Ctrl+R



MIDI Auto Reset Switch

This switch causes a MIDI reset sequence to be transmitted on all channels when playback is stopped.    
The reset sequence is as follows:

Bx 7B 00 ;all notes all
Bx 01 00 ;modulation wheel to zero
Bx 07 7F ;volume to max (127)
Bx 40 00 ;sustain pedal off
Ex 00 40 ;centre pitch wheel

The MIDI Reset command can be used to output the reset sequence on demand.



MIDI System Exclusive Command

This command is used to send and receive bulk MIDI data.    Normally this would be MIDI System 
Exclusive messages.

The dialog box displayed will allow you to load and save files from disk, move data into and out of the 
clipboard and send or receive data from the MIDI device.    Each of these operations is described here.

Receiving data from a MIDI Device

The combo-box and Receive button are used to receive data from an attached MIDI device.    The request
string currently shown in the combo-box is transmitted, and the program records everything it receives.    
The number of bytes received is displayed while recording.    To stop recording, press the Stop button.    
The request strings can be customized using the Sys Ex Customize command.

Sending data to a MIDI Device

The Send button causes the current contents of the buffer to be transmitted.    A delay is inserted between
MIDI System Exclusive messages, which can be adjusted using the Sys Ex Customize command.

Loading and Saving Data

The Load button is used to load a file into the buffer.    The Save button is used to save the current 
contents of the buffer in a file.    These files are in a standard format, normally known as MIDIEX.    This 
type of file contains raw MIDI data, without any headers or other information.    This format is widely used, 
which allows files to be readily shared.

Filtering the Buffer

The Filter button causes the current contents of the buffer to be examined and all data other than MIDI 
System Exclusive data to be deleted.    This would normally be done after recording a bulk dump.

Clipboard Support

The Copy and Paste buttons are used to exchange data with other programs through the Windows 
clipboard.    The Copy button causes the current contents of the buffer to be converted into readable 
ASCII, and placed into the clipboard as a text file.    This can then be edited by a program such as 
Notepad.    The Paste button performs the reverse, the contents of the clipboard are converted back into 
raw data, and placed into the clipboard.

The input accepted by Paste may contain comments and blank lines as required to make the file more 
understandable by humans.    The format used is compatible with the old format accepted by the old MIDI 
Send Hex command from the previous versions.    The following is an example of a valid file.

;
; The following will set the master volume of a MT32 to 100
; Comments are from a semicolon to the end of the line
;

; Blanks, Tabs and New Lines are ignored
; UPPER and lower case are allowed in hex numbers

F0 41 10 16 12 10 00 16 64 76 F7



; the following repeats the previous command

f0 4110161210 0 166476 f7



MIDI Sys Ex Customize Command

This command is used customize the settings used in the System Exclusive command.    This includes the
various dump request commands, the default MIDIEX file extension and the delay between system 
exclusive commands when transmitting.

Although the request strings were intended to be used to request dumps from MIDI devices, any string 
that you wish to send can be entered here.    For example, you may wish to include a reset command 
which you occasionally need to send.

Whenever this command is executed and there are no request strings stored, the strings will be reloaded 
from the executable file.

Help!

I would like to expand the default request strings beyond the current MT-32 strings, but I need your help 
to do this.    If you have some request strings which you would like to see included in a future release of 
WinJammer I would be happy to add them.    Just send them to me and you'll see them next time around.



MIDI Advanced Command

This dialog contains a number of "advanced" switches used to control WinJammer's behaviour.    Under 
normal circumstances, these switches do not need to be used.

Selecting Ports

This section of the dialog allows you to select the port number to be used for MIDI Thru and Real Time 
events.    Refer to the MIDI Configure dialog to determine the port number for each device.

MIDI Messages

The three switches in this section control how WinJammer deals with MIDI Real Time messages.

The Wait for MIDI Start switch determines whether WinJammer responds to or ignores the MIDI real time
messages: Start (0xFA), Stop (0xFC) and Continue (0xFB).    If the switch is on, a MIDI Stop will cause 
playing or recording to stop.    If the switch is on, a MIDI Start or MIDI Continue will cause recording or 
playback to start.    Otherwise a Start or Continue message is ignored.    WinJammer makes no distinction 
between Start and Continue.

If this switch is on, starting play or record will set WinJammer up for the operation, but not actually start it. 
The Toolbar will show "Waiting..." instead of a beat number.    When the MIDI Start or Continue is 
received, this will change to the normal beat counter.    If a MIDI Stop is then received, play or record will 
stop.

In order to use this switch, you must have a MIDI input device.

The Send MIDI Clocks switch determines whether WinJammer will send MIDI Clock messages (0xF8) 
during playback or recording.    MIDI Clocks are used to synchronize with external devices during 
playback.

The Send MIDI Start/Stop switch determines whether WinJammer sends MIDI Start/Continue or Stop 
messages.    If this switch is on, a MIDI Start or MIDI Continue message will be sent when playback or 
recording is started, and a MIDI Stop message is send when stopping.    A Start message is sent if 
playback starts at the beginning of the song, otherwise a Continue message is used.

Clock Source

The Internal switch is used to have WinJammer generate it's own timing source.    This is the normal 
choice.    This means that the song's tempo is determined by the tempo commands contained in the song.

The MIDI switch is used when an external MIDI device is to be used as the "master".    This external 
master device must send MIDI clock events 24 times per beat.    This is used to control the tempo of all 
recordings and playbacks.    When MIDI Clocking is used, any tempo events in the song are ignored.    
The tempo bar in the Toolbar window is also ignored.

Timer Resolution

This value defines the highest frequency that the computer's clock is to be run.    Under normal 
circumstances, this should be left at the default of 1 msec (1000 times per second).    This provides for the
most accurate clock possible.

A higher value will cause the clock to occur less often, causing a lower overhead and better overall 
performance in Windows.    On slower machines, it may be better to use a value of 5 msec.



Reset to Defaults

This button will some switches to their default values.    This will cause the Wait for MIDI Start switch to 
be turned off, the Send MIDI Clocks and Send MIDI Start/Stop switches to be set, and the Internal 
clock to be selected.



MIDI Configure Command

This command is used to configure WinJammer for the hardware on your particular machine.    You must 
do this before you can play or record.

The dialog box displayed is used to select the devices to be used.    The list of available devices will 
depend on the drivers you have installed.    Simply select the desired input and output devices, then press
Ok.    It is possible to reconfigure WinJammer whenever you choose.

Control Panel

The Windows Control Panel application is used to configure Windows for your equipment.    There are two
steps required to set up MIDI devices.

1. Install the drivers: The first step is to install drivers for your hardware.    This is done through the 
Drivers icon in the Control Panel.    When first started, you will be presented with a list of the installed 
drivers.    Press the Add button to add more drivers to the list.    Depending on the driver, you may be 
asked for the hardware configuration information.    Once all of the drivers are added, you will have to 
restart Windows to make the new drivers available.

2. Configure the MIDI Mapper: The MIDI Mapper is a special MIDI output device that is used to remap 
songs from the General MIDI Specification to whatever equipment you have.    You can start the MIDI 
Mapper by clicking on the icon in the Control Panel.    The dialog shown will allow you to select your setup
from one of the defaults.    If you get a message saying that the current setup references a device that you
don't have installed, then you'll have to either edit the configuration or choose a different one.    See your 
Windows manual for more details.

WinJammer MIDI Configuration

Now that the proper devices are installed, you can use the MIDI Configure command in WinJammer to 
select the appropriate input and output device.    Note that the MIDI Mapper is sometimes slow - you'll 
notice this in particular when editing a track with the Sound Event switch turned on.

If you are simply playing songs, there is no need to specify an input device.    Some operations require an 
input device however.



Song Timebase Command

This command sets the number of "ticks per beat" used in a song.    This effects the resolution of a song's 
timing.    In standard time (4/4), the number of ticks per beat is the number assigned to a quarter note.

The song's timebase can be set or changed at any time.    When the timebase is changed, all events are 
adjusted to conform to the new timebase.    A note that was a quarter note before will start at the same 
time, and still be a quarter note.

When a ROL file is imported, or when you load a file from another sequencer, you may get an error 
message when you try to play the song saying that the timebase is invalid.    If this occurs, simply adjust 
the timebase to one of the values listed in the Song Timebase dialog box.    If in doubt as to what to 
choose, try 120.



Song Key Command

The Song Key command is used to specify the current song's key signature.    Currently only a single key 
signature can be used for a song, although it can be changed anytime.

The key signature is used to determine the name of each note in the Event List window.    It is also used to
determine the colour and placement of the note on the staff in the Piano Roll window.

For example, if the key signature was G (one sharp), then the names of any accidentals would be 
changed to reflect a sharp rather than a flat (C# instead of Db).    In the Piano Roll window, an F# would 
now be displayed as a normal note in gray rather than a note in gray.

This command has no effect on anything other than how the notes are displayed.    Changing the key 
signature will not cause and tracks to be automatically transposed.



Song General MIDI Switch

This switch is used to mark the current song as a General MIDI song.    This causes a special meta event 
to be added to the song when it is played.    The Microsoft Media Player program will issue a warning 
before playing any song that does not have this special marker.    The only purpose of this switch is to 
suppress this warning.



Event List Window

This window is used to edit the contents of the current track.    The track events are displayed in a list 
format, so all events in the track can be edited and viewed in this window.

Events are selected in the Event List window by moving the select bar to the desired event.    The list can 
be scrolled using the scroll bar or normal Windows scrolling keys.

There are various commands available when using the Event List window.    These are fully explained in 
the following topics.

Event Menu Used to insert/delete/edit single MIDI events
Options Menu Customize WinJammer.

The following topics will help to describe how to perform various tasks in the Event List window.

Switching Windows How to switch between active windows.
Opening Windows Starting one of the windows.
Closing Windows Destroying one of the windows.
Selecting Events How to select an event to edit.

Event List Abbreviations

In the Event List screen different abbreviations are used to depict the various event types.    The following 
is a list of the abbreviations used and where appropriate, their MIDI status byte.

Tempo set a new Tempo for song
TimeSig change in Time Signature

Text General Purpose Text
© Copyright Notice
Lyric Lyric to be sung
Marker Name of a point in the sequence
Cue Pt Cue Point

Note On MIDI Note On event: 0x9n
KeyPres MIDI Key Pressure (Key After Touch): 0xAn
CtrlChg MIDI Control Change: 0xBn
Pgm Chg MIDI Program (patch) Change: 0xCn
CnlPres MIDI Channel Pressure (After Touch): 0xDn
PtchWhl MIDI Pitch Wheel (Bender): 0xEn
Sys Ex MIDI System Exclusive Message: 0xF0



Piano Roll Window

This window is used to display and edit the contents of the current track.    The track's note events are 
displayed in a graphical format, similar to both standard musical notation and "piano roll" notation.

Each note event is shown in a standard musical staff as a rectangle.    The vertical position of the 
rectangle is the correct location on the staff, depending on the Song Key.    The note's starting time 
determines the start of the rectangle, and the width of the rectangle is determined by the length of the 
note.    Accidentals (sharps and flats) are shown in a second colour.

The screen can be scrolled horizontally using either the scroll bar or the cursor keys.    If some notes are 
not being displayed because the window is too small, the window can be resized so that they may be 
seen.

There are various commands available when using the Event List window.    These are fully explained in 
the following topics.

Event Menu Used to insert/delete/edit single MIDI events
Options Menu Customize WinJammer.

The following topics will help to describe how to perform various tasks in the Event List window.

Switching Windows How to switch between active windows.
Opening Windows Starting one of the windows.
Closing Windows Destroying one of the windows.
Selecting Events How to select an event to edit.



Audition Patches Window

The Audition Patches Window is used to control a song while it is playing.    It consists of two groups of 
controls, each of which is used to control different aspects of the playback.

Metronome

The controls contained in the Metronome box are used to control the metronome and the count-in at the 
start of the playback.    The buttons are used to turn the metronome off, on or on with accents at the start 
of each measure.    The number of beats of initial delay is entered as the count in amount.

The metronome is only active while playing or recording.    If the Record Only switch is checked, the 
metronome will only be heard when recording.

The MIDI Metronome command is used to customize the notes used to sound the metronome.

Patches

The patches section is used to display the last patch (MIDI program change) sent on each MIDI channel.   
Every time a patch is sent on a channel, the screen is updated.    If you have more than one output port, 
you can select which port's patches are seen.

If you would like to experiment with different patches while the song is being played, you can edit the 
patch number for any MIDI channel.    Simply input the new patch number, and it will be sent out the 
correct channel.

You can also change the patch number for any channel when the song is not playing, because any patch 
number entered is immediately sent.

The Lock Patches switch controls whether the patches contained in the song are to be sent.    If this 
switch is on, then the patches in the song are filtered from the tracks as the song is played.    This allows 
you to easily fiddle with the patches for the song without having to edit the individual tracks.



Event Menu

The Event Menu on the Event List and Piano Roll windows is used to edit, insert and delete events in a 
track.    It contains the following commands.

Edit Edit the currently selected event.
Insert Insert a new event into the track.
Delete Delete the currently selected event.
Duration Change the length of the note and adjust next note.
Rest Add rest before current event.
Chord Create a chord with two events.
Search Search for an event type.
Next Search for the next event of the selected type.
Previous Search for the previous event of the selected type.
Dotted Make dotted notes.
Triplet Make triplets.
1 Turn current note into a whole note.
2 Turn current note into a half note.
3 Turn current note into a quarter note.
4 Turn current note into a eighth note.
5 Turn current note into a sixteenth note.
6 Turn current note into a thirty-second note.
7 Turn current note into a sixty-fourth note.



Event Edit Command

This command is used to edit the currently selected event.

A dialog box will be displayed containing the current event.    Any changes can then be made to the event. 
Whenever a change is made, it is validated, and if the entered value is illegal then a valid value is 
substituted.

When entering a note name, use either the + or # keys for a sharp, and either - or b for a flat.

The middle C octave number and patch base can be set using the Options Preferences command.    The 
current setting of the Options Relative switch will also effect the way a change in time is handled.

Short Cut Key: Enter or Double Click



Event Insert Command

This command is used to insert a new event into a track.

A dialog box is displayed asking what type of event you want to insert.    Once you have selected an event
type, a second dialog box is displayed to allow entry of the event.    This second dialog box will be filled in 
with as much information as is possible from the currently selected event.

There is no requirement to insert events in sequence in the track as WinJammer will automatically find the
appropriate location in the track for your new event.

When entering a note name, use either the + or # keys for a sharp, and either - or b for a flat.

The middle C octave number and patch base can be set using the Options Preferences command.

Short Cut Key: Ins



Event Delete Command

This command is used to delete the currently selected event from the track.

While is it not possible to undo an event that was deleted by accident, you can undo all of your changes 
to the track by closing the Event List or Piano Roll window, then selecting Edit Undo from the main menu.

Short Cut Key: Del



Event Duration Command

This command is used to adjust the length of the current note, and the start time of all subsequent events.

A dialog box is displayed asking for the duration of the current note.    Enter the note's desired length in 
ticks, depending on the current Timebase, which is displayed for you.    The length of the note will be set 
to one tick less than the entered time, and the start time of all events following it in the track will be 
adjusted to the entered time.

For example, assume that the current timebase was 120, and the track contained the following:
0:118 Note On 3 C 5 64 0:073
1:112 Note On 3 E 6 65 1:010
2:049 Note On 3 F 5 40 0:080

If a duration command was performed on the first event, setting the duration to 1:000 (one beat), the 
result would be:

0:118 Note On 3 C 5 64 0:119
1:118 Note On 3 E 6 65 1:010
2:055 Note On 3 F 5 40 0:080

Short Cut Key: D

There are also short cut keys for some of the common duration commands.    These are:

Dotted Make dotted notes
Triplet Make triplets
1 Turn current note into a whole note
2 Turn current note into a half note
3 Turn current note into a quarter note
4 Turn current note into a eighth note
5 Turn current note into a sixteenth note
6 Turn current note into a thirty-second note
7 Turn current note into a sixty-fourth note



Event Rest Command

This command is used to add time to the current start time of the current event.

A dialog box is displayed asking for the length of the rest.    Enter the desired rest length in ticks, 
depending on the current Timebase, which is displayed for you.    The amount entered will be added to the
start time of the current event, and all subsequent events in the track.

For example, assume that the current timebase was 120, and the track contained the following:
0:118 Note On 3 C 5 64 0:119
1:118 Note On 3 E 6 65 1:010
2:055 Note On 3 F 5 40 0:080

If a rest command was performed on the first event, entering a value of 0:2, the result would be:
1:000 Note On 3 C 5 64 0:119
2:000 Note On 3 E 6 65 1:010
2:057 Note On 3 F 5 40 0:080

Short Cut Key: R



Event Chord Command

This command is used to adjust the start time of the current event to be the same as the start time of the 
previous event, thus creating a chord.

If this command is executed on the first event in a track, the start time of the event is set to zero.

For example, assume that the current timebase was 120, and the track contained the following:
1:000 Note On 3 C 5 64 0:119
2:000 Note On 3 E 6 65 1:010
2:057 Note On 3 F 5 40 0:080

If a rest command was performed on the first event the result would be:
0:000 Note On 3 C 5 64 0:119
1:000 Note On 3 E 6 65 1:010
1:057 Note On 3 F 5 40 0:080

Short Cut Key: C



Event Search Command

This command is used to search for an event type in the current track.    When the command is used, a 
dialog box is displayed asking for the event type to search for.    The track will then be searched for the 
next event of the selected type.

The Next and Previous commands can be used to quickly search for the next or previous occurrence of 
the event.

Short Cut Key: S



Event Next Command

This command is used to search for the next occurrence of an event in the current track.    The event type
to search for is selected through the Search command.    This command will search forward in the current 
track looking for an event of the correct type.    If one is found, then the track is positioned at the event.

Short Cut Key: N



Event Previous Command

This command is used to search for the previous occurrence of an event in the current track.    The event
type to search for is selected through the Search command.    This command will search backward in the 
current track looking for an event of the correct type.    If one is found, then the track is positioned at the 
event.

Short Cut Key: P



Event Dotted Switch

This switch modifies the current quick duration commands so that the durations that they specify are 
increased by half.    If this switch is on, a quick duration of a Half Note is equal to three beats instead of 
two.

If this switch is on and the Triplet switch is also on, then the quick duration commands are normal.    This 
is because the Triplet switch decreases the duration by 2/3 and the Dotted switch increases the duration 
by 1 1/2.

Short Cut Key: .



Event Triplet Switch

This switch modifies the quick duration commands so that the durations that they specify are decreased.   
If this switch is on, three notes will fit in the time that two notes would have fit in before.

If this switch is on and the Dotted switch is also on, then the quick duration commands are normal.    This 
is because the Triplet switch decreases the duration by 2/3 and the Dotted switch increases the duration 
by 1 1/2.

Short Cut Key: T



Event Whole Note Command

This command is a quick way of specifying a Duration of 4 times the current Timebase for the currently 
selected note.    In 4/4 time, this would equal one whole note.

Short Cut Key: 1



Event Half Note Command

This command is a quick way of specifying a Duration of two times the current Timebase for the currently 
selected note.    In 4/4 time, this would equal one half note.

Short Cut Key: 2



Event Quarter Note Command

This command is a quick way of specifying a Duration equal to the current Timebase for the currently 
selected note.    In 4/4 time, this would equal one quarter note.

Short Cut Key: 3



Event Eighth Note Command

This command is a quick way of specifying a Duration of half the current Timebase for the currently 
selected note.    In 4/4 time, this would equal one eighth note.

Short Cut Key: 4



Event Sixteenth Note Command

This command is a quick way of specifying a Duration of one quarter of the current Timebase for the 
currently selected note.    This is normally equal to one sixteenth note.

Short Cut Key: 5



Event Thirty-second Note Command

This command is a quick way of specifying a Duration of one eighth of the current Timebase for the 
currently selected note.    This is normally a one thirty-second note.

Short Cut Key: 6



Event Sixty-fourth Note Command

This command is a quick way of specifying a Duration of one sixteenth of the current Timebase for the 
currently selected note.    This is normally a one sixty-fourth note.

Short Cut Key: 7



Options ROL Pitch Wheel Switch

The Options ROL Pitch Wheel switch is used to determine whether MIDI Pitch Wheel events are to be 
generated when importing a ROL file.

If this switch is on (checked), then Pitch Wheel events will be generated when a ROL file is imported with 
the File Import command.    All ROL files contain pitch wheel events, which if translated often cause the 
resulting MIDI file to sound "off".    Under normal circumstances, it is probably best to turn this switch off.    
If you wish to remove pitch wheel events after the file has been imported, the Track Filter Events 
command can do this.



Options ROL Save Patches Switch

The Options ROL Save Patches switch controls whether the patch re-mapping specified when importing a
file will be saved in the INI file.

When a ROL file is imported with the File Import command, a dialog box is displayed which allows you to 
specify MIDI patch numbers for each of the instruments in the original ROL file.    If this switch is on 
(checked), then when Ok is pressed to apply this re-mapping, then the assignments you have made will 
be kept for next time.    Over time, this will make importing ROL files easier, since the proper assignment 
of patches is already known.



Options Preferences Command

The Options Preferences Command is used to customized WinJammer to your machine and preferences.
The following changes can be made.

Patch Base controls the first patch number used by your MIDI instrument.    This only effects the way 
patch numbers are displayed and entered.    Some companies such as Roland and Yamaha number their 
patches from 1 through 128, while other manufactures number patches from 0 through 127.    Default is 1.

Middle C Octave controls the octave number assigned to middle C.    Again different manufactures have 
chosen to use different notation, so WinJammer allows you to choose which ever octave is better for you. 
For example Yamaha uses C3 for middle C, while Roland uses C4.    Default is C5.

Note Width controls the number of beats that can be fitted onto one maximized Piano Roll window.    A 
higher number will show more beats on the screen, although each note will be narrower.    Default is 16.

Note Height controls the height of a note in the Piano Roll window.    This is actually the number of pixels 
used to draw the note's rectangle on the screen, and must be an odd number.    Default is 5.    A value of 5
is suggested for a VGA screen.

Velocity Scale is an amount used to divide a note's velocity by to determine the height of the line to 
display.    A scale amount of 1 will cause the velocity area of the Piano Roll screen to be larger than it 
would be with a scale of 4.    Default is 4.



Options Relative Switch

This switch controls the interpretation of a change in an event's starting time when the Edit Event 
command is used.

If the switch is off, a change in the start time of an event will cause the event to be moved to a new 
location in the track.

If the switch is on, WinJammer moves this event to the new starting time, and shifts all events following it 
in the track as well.    If the new time entered is before the start time of the previous event in the track, the 
time is considered to be invalid, and no change is made.

With the switch on, it's very easy to insert a rest into a track, or perform a bit of manual quantizing.



Options Velocity Switch

This switch determines whether the velocity of each note is shown in the Piano Roll window.

If the switch is on, each note will cause a vertical line to be displayed showing a graphic representation of 
the note's velocity.    The longer the line, the higher the velocity.    For reference purposes, a horizontal line
is drawn representing the height of a velocity of 64.



Options Dashed Lines Switch

This switch determines whether or not dashed lines are drawn in the Piano Roll Screen.

If on, dashed lines are drawn wherever a line would normally go.    For example, if the Alto Clef is not 
displayed and dashed lines are on, Middle C would have a dashed line drawn through it.

Dashed lines are intended to help locate a note that is off the normal staff lines.



Options Clef Switches

WinJammer will display three different types of clefs in the Piano Roll screen.

Most piano music uses a "grand" clef, which includes a treble and bass clef.    Guitar music, "fakebooks" 
etc often only contain a treble clef.    Some orchestral instruments such as a Viola use the Alto clef, which 
has Middle C as its middle line.

You can select which clefs you would like to see in the Piano Roll screen.    Regardless of the clef chosen,
middle C is always located in the centre of the screen.    If an Alto clef is chosen, neither a Treble or Bass 
clef can be shown as they would overlap.



Options Sound Event

This switch is used to determine whether WinJammer should play each note as it is selected in either the 
Event List or Piano Roll windows.

If this switch is on, as each event is selected in the Event List or Piano Roll windows, the event is sent as 
well.    If the event is a note event, the length of the note will be about half a second.    If you move rapidly 
between notes, the last note will be cut off to avoid slowing your movement down.



MIDI File Format

WinJammer will read and write standard MIDI format song files.    This is a common format supported by 
most of the music programs on the market today.

WinJammer will read MIDI files, any format.    Reading a format other than 0 or 1 will cause a warning to 
be displayed, because these are the only formats WinJammer understands.    The only other currently 
defined format is type 2, which consists of multiple tracks which play one at a time.    It should be possible 
to edit a format 2 file into a valid song using WinJammer.

WinJammer can save files as either format 1 or 0.    The maximum number of tracks in the file is 64.    To 
create a format 0 file, merge all tracks into track zero and save the file.    If there are more than one track 
in the file, WinJammer will save it as in format 1.

All MIDI channel events are supported (status bytes from 0x80 through 0xEF).    None of the MIDI non-
channel events (status bytes from 0xF0 through 0xFF) are supported in a track, except for a system 
exclusive message (0xF0).

WinJammer supports only a subset of the possible meta events which can occur in a file.    WinJammer is 
capable of reading files containing any meta event, and supports most meta events.    Any meta event that
it doesn't recognize is ignored.    The supported meta events are:

0x01 Text Event
0x02 Copyright Notice
0x03 Track Name
0x04 Instrument Name (patch name)
0x05 Lyric
0x06 Marker
0x07 Cue Point
0x21 Port Number
0x2F End of Track
0x51 Tempo
0x58 Time Signature
0x59 Key Signature

All tracks containing MIDI Note Off messages (status byte 0x80 through 0x8F) will have these events 
mapped into Note On commands with a velocity of zero.    This will normally result in a smaller track 
because a new status byte does not always have to be output (MIDI running status).    Files can be further
compressed by using a different track for each MIDI channel, and possibly using separate tracks for 
continuous events (pitch wheel, channel after touch, note pressure).

MIDI Format type 0 files contain only one track, which has all of the meta events as well as the data 
streams for each MIDI channel.    Whenever a type 0 file is loaded, it's suggested that the track should be 
split in order to form a valid type 1 file.    This will also assist in editing/voicing the song.

MIDI Format type 1 files are supposed to contain only non-note events in track 0 (tempo changes, time 
signature changes etc).    All other tracks are only supposed to contain MIDI events.    While WinJammer 
does not require this to be true, it is a good way to organize your song's tracks.    You should certainly 
follow this rule if you expect to use the saved file with any other sequences.



Windows and MIDI

In this topic, the steps required to install the MIDI drivers is explained.    A more complete discussion can 
be found in the Windows manuals.

Installing a Device Driver

When Windows is installed, it does not setup any drivers for your MIDI devices.    This must be done 
separately.

The Windows Control Panel application is used to install the MIDI drivers.    Start the Control Panel by 
double clicking on its icon in the Main group.    

Double click on the Drivers icon inside the Control Panel.    A list of the currently installed drivers will 
appear.    If you haven't installed any drivers yet, the list should contain the MIDI Mapper, the Timer, [MCI] 
MIDI Sequencer and the [MCI] Sound driver.

To add a new driver, press the Add button.    A list of the available drivers will be displayed.    Highlight the 
driver for your device and press the Ok button.    Windows will ask you to insert a diskette containing the 
selected driver.    Do this for as many devices as you have.

If the driver you need is not listed, check any diskettes that came with your device.    Most likely the driver 
is there.    Select the Unlisted or updated driver entry and Windows will prompt you to insert the diskette
so it can read it.

Some drivers will require information such as port number or an interrupt number.    The default location 
for a Sound Blaster card is 220, interrupt 7.    The default for a MPU-401 type of MIDI interface (including 
the Roland LAPC and SCC-1 cards) is 330, interrupt 2/9.

After this is done, Windows will ask you if you'd like to restart Windows.    This is necessary because 
Windows installs the MIDI drivers when it first loads.    Select Restart Now and Windows will restart.

Configuring WinJammer

After Windows been restarted, double click on the WinJammer icon.    Refer to the MIDI Configure 
command for information on configuring WinJammer.

The MIDI Mapper

One of the possible output devices is the Microsoft MIDI Mapper.    It is best to avoid the MIDI Mapper 
unless you have to use it.    It adds extra overhead, and can cause problems.

Important Note:    Sound    Blaster 1.0 and 1.5 owners.
The Sound Blaster 1.0 and 1.5 do not support simultaneous MIDI input and output.    It is possible to 
use the internal FM synthesizer for output and the MIDI port for input.    Alternately, select the Sound 
Blaster MIDI port for output, and select <none> for the input device.



Windows MIDI Mapper

The Windows MIDI Mapper is a program which adjusts the MIDI events sent by a program such as 
WinJammer, before the actual device driver receives the event to output.    There are three things which 
the MIDI Mapper will adjust: patch numbers, channel numbers and note numbers.

The MIDI Mapper assumes that the output from these programs is in accordance with the General MIDI 
specification.    The MIDI Mapper then remaps the output events as required for your device.    Normally 
this will only affect songs played to MIDI keyboards which do not support the General MIDI specification 
themselves.

To setup a map for your device open the control panel.    Double click on the MIDI Mapper Icon. If another 
program is using the MIDI Mapper you will be unable to change the MIDI Mapper settings.    Close the 
other program and open the MIDI Mapper again.    A dialog box will appear with three main settings.    
These are Setup, Patch Maps and Key Maps.    Below this will be a combo-box with a preselected setup.   
Click on the down arrow.    A list of the setups currently known to Windows will appear.    Select the setup 
that matches your device.    If your device is not present check the instructions that came with your device.
For many devices, you will have to create a new setup.

Press the Edit button to edit the currently selected setup.    A table will appear that shows Source and 
Destination channels.    By editing this table it is possible to redirect MIDI events to other channels and 
devices.    For example channel 10 is used for drums by the General MIDI specification, and some 
devices such as those made by Yamaha use channel 16 for drums.    Using the setup you can reroute 
channel 10 to 16 if you have a Yamaha keyboard.    Next to this is the Port Name.    If you have more than 
one output device, you can alter the setup so that some channels are routed to one device and some to 
another.    Do not do this if you have configured WinJammer to use these devices directly.    The MIDI 
Mapper will not share the ports listed with other programs.    For keyboards, you can set the port to a MIDI
output device, like an MPU-401, and then select a patch map.    Adlib, Sound Blaster and most 
compatibles will not have to do this.    Refer to your manufacturers instructions on how to setup using 
Windows.

If you have defined, or need to define, a patch map, click on the Patch Maps button and then click on the 
down arrow.    A list of the currently available patch maps will be displayed.    If yours is not displayed, 
create a new one.    Pressing Edit or New will display a Patch Map table.    This table lists the General 
MIDI specification patches and patch names on the left.    The next column is the Destination patch 
number.    You can edit this number to match the patches defined for your device.    Check the 
manufacturers manual for details.    When you are done click on Ok and then Click on Close.    This will 
save your new setup and patch maps.

The MIDI Mapper will make use of the setup and patch maps to transform the data being sent from 
programs like WinJammer so that the data is understandable by your output device.    This requires that 
any songs played using the MIDI Mapper be created according to the General MIDI specification.



General MIDI Specification

The following table lists the names of each of the General MIDI patch numbers.    This mapping is 
assumed for all events on all channels other than channel 10.    Channel 10 is reserved for the drum track.
Note that similar instruments are grouped together.

General MIDI Patch Map

# Piano # Chromatic Percussion
1 Acoustic Grand Piano 9 Celesta
2 Bright Acoustic Piano 10 Glockenspiel
3 Electric Grand Piano 11 Music Box
4 Honky-Tonk Piano 12 Vibraphone
5 Rhodes Piano 13 Marimba
6 Chorused Piano 14 Xylophone
7 Harpsichord 15 Tubular Bells
8 Clavinet 16 Dulcimer

# Organ # Guitar
17 Hammond Organ 25 Acoustic Guitar (nylon)
18 Percussive Organ 26 Acoustic Guitar (steel)
19 Rock Organ 27 Electric Guitar (jazz)
20 Church Organ 28 Electric Guitar (clean)
21 Reed Organ 29 Electric Guitar (muted)
22 Accordion 30 Overdriven Guitar
23 Harmonica 31 Distortion Guitar
24 Tango Accordion 32 Guitar Harmonics

# Bass # Strings
33 Acoustic Bass 41 Violin
34 Electric Bass (finger) 42 Viola
35 Electric Bass (pick) 43 Cello
36 Fretless Bass 44 Contrabass
37 Slap Bass 1 45 Tremolo Strings
38 Slap Bass 2 46 Pizzicato Strings
39 Synth Bass 1 47 Orchestral Harp
40 Synth Bass 2 48 Timpani

# Ensemble # Brass
49 String Ensemble 1 57 Trumpet
50 String Ensemble 2 58 Trombone
51 SynthStrings 1 59 Tuba
52 SynthStrings 2 60 Muted Trumpet
53 Choir Aahs 61 French Horn
54 Voice Oohs 62 Brass Section
55 Synth Voice 63 Synth Brass 1
56 Orchestra Hit 64 Synth Brass 2

# Reed # Pipe
65 Soprano Sax 73 Piccolo
66 Alto Sax 74 Flute
67 Tenor Sax 75 Recorder
68 Baritone Sax 76 Pan Flute
69 Oboe 77 Blown Bottle
70 English Horn 78 Skakuhachi



71 Bassoon 79 Whistle
72 Clarinet 80 Ocarina

# Synth Lead # Synth Pad
81 Lead 1 (square) 89 Pad 1 (new age)
82 Lead 2 (sawtooth) 90 Pad 2 (warm)
83 Lead 3 (calliope lead) 91 Pad 3 (polysynth)
84 Lead 4 (chiff lead) 92 Pad 4 (choir)
85 Lead 5 (charang) 93 Pad 5 (bowed)
86 Lead 6 (voice) 94 Pad 6 (metallic)
87 Lead 7 (fifths) 95 Pad 7 (halo)
88 Lead 8 (brass + lead) 96 Pad 8 (sweep)

# Synth Effects # Ethnic
97 FX 1 (rain) 105 Sitar
98 FX 2 (soundtrack) 106 Banjo
99 FX 3 (crystal) 107 Shamisen
100 FX 4 (atmosphere) 108 Koto
101 FX 5 (brightness) 109 Kalimba
102 FX 6 (goblins) 110 Bagpipe
103 FX 7 (echoes) 111 Fiddle
104 FX 8 (sci-fi) 112 Shanai

# Percussive # Sound Effects
113 Tinkle Bell 121 Guitar Fret Noise
114 Agogo 122 Breath Noise
115 Steel Drums 123 Seashore
116 Woodblock 124 Bird Tweet
117 Taiko Drum 125 Telephone Ring
118 Melodic Tom 126 Helicopter
119 Synth Drum 127 Applause
120 Reverse Cymbal 128 Gunshot

General MIDI Percussion Key Map

The following table shows the sound assigned to each MIDI note on channel 10.

# Drum Sound # Drum Sound
35 Acoustic Bass Drum 59 Ride Cymbal 2
36 Bass Drum 1 60 Hi Bongo
37 Side Stick 61 Low Bongo
38 Acoustic Snare 62 Mute Hi Conga
39 Hand Clap 63 Open Hi Conga
40 Electric Snare 64 Low Conga
41 Low Floor Tom 65 High Timbale
42 Closed Hi-Hat 66 Low Timbale
43 High Floor Tom 67 High Agogo
44 Pedal Hi-Hat 68 Low Agogo
45 Low Tom    69 Cabasa
46 Open Hi-Hat 70 Maracas
47 Low-Mid Tom 71 Short Whistle
48 Hi-Mid Tom 72 Long Whistle
49 Crash Cymbal 1 73 Short Guiro
50 High Tom 74 Long Guiro
51 Ride Cymbal 1 75 Claves
52 Chinese Cymbal 76 Hi Wood Block



53 Ride Bell 77 Low Wood Block
54 Tambourine 78 Mute Cuica
55 Splash Cymbal 79 Open Cuica
56 Cowbell 80 Mute Triangle
57 Crash Cymbal 2 81 Open Triangle
58 Vibraslap



MIDI Glossary

Aftertouch:    The change in pressure on a key after the initial key press.    Normally used to control 
vibrato or other characteristics.

Bar:    A synonym for a measure.    A musical time, a grouping of beats.

Beat:    Literally, a single stroke or pulsation.

Buffer:    A temporary storage area in memory.

Bulk Dump:    Denotes a series of MIDI System Exclusive messages. Sometimes, this involves 
transferring a mass of data, like several choruses of a song that have been stored in memory from the 
keyboard to the sequencer or vice versa.

Channel:    In MIDI, channels are used to separate different sections of a song that are going to play 
simultaneously.    Each channel is assigned to a single instrument in any particular instant of time.    One 
channel is usually reserved for a percussion voice.

Clef:    That symbol at the beginning of a staff, the one that determines the pitch.

Clock:    A clock is used to synchronize two devices.    In MIDI, the term clock is used to denote a single 
time source, which everything plays along with.    MIDI clocks are actually special messages that are sent 
24 times (normally) per beat, and are used to synchronize two sequencers, or a sequencer and a drum 
machine. Normally, the sequencer's clock is the important one.    Other clock sources are rarely used.

Controller:    In sequencing, refers to a setting, a parameter, such as controller 7 (volume).    In this 
sense, a controller is a MIDI event.

Controller Change:    This event will be displayed in the Event List window.    It refers to a change in a 
synthesizer setting.    There are 128 possible MIDI controllers.

Count In:    A command in a sequencer that plays a metronome for several measures until you are ready 
to record.

Cut-And-Paste:    In word-processing, this function means moving text from one place in a document to 
another.    In MIDI, one can copy a section of a musical passage and paste it elsewhere.

Data Bytes:    These are the bytes which follow the status byte in a MIDI message, e.g., what note has 
been struck, how hard.

Filter:    The noun and the verb, in MIDI, are used primarily in connection with events (note on, program 
change, tempo change...) and with channel changes.    Each event is either filtered (deleted), transformed,
or passed through.

General Midi Mode:    A convention specifying how a sequence (a song) should be constructed, so that it 
will play on a variety of hardware.

Import:    To bring data from one program into another.

Instrumentation:    The selection of instruments in a MIDI arrangement.

Key Signature:    Musical notation shows this in terms of sharps and flats after the clef.    Software 
sequencers usually show a song key as "F Major/D Minor," and indicate the number of sharps or flats.    



B-flat Major/G Minor has two flats, for example.

Messages:    The net effect of MIDI-computing is sound: melodies, harmonies, rhythms...    But the MIDI 
message (the MIDI event) itself is not a sound.    Transmitted are digital commands--about 1,000 events 
per second.

Metronome:    A device to mark time by producing a repeated tick.    The older type--a triangular box with 
a vibrating arm--was succeeded by an electrical unit.    In MIDI, the ticks are computer-generated.

MIDI.    An acronym for Musical Instrument Digital Interface.    This is a standard protocol for 
communication between musical devices.

MIDIEX File:    MIDIEX is a de-facto standard file format, containing raw MIDI data without a header.

MIDI Mapper:    Microsoft's utility program, which can help in remapping patch, channel, etc. during 
playback.

MIDI Thru:    One of the three defined MIDI port types.    A MIDI In port receives information from other 
equipment.    A MIDI Out port sends information to other equipment.    A MIDI Thru port outputs the 
information received through a MIDI In port, sending it to other equipment.    This allows for MIDI events to
be echoed to other synthesizers.

MPU-401 Compatible:    The original Roland MPU-401 was the most popular MIDI interface for IBM PCs, 
and is still the most widely supported.    Many manufacturers (including Roland) make compatible MIDI 
interfaces.

Multi-Timbral:    In MIDI, a multi-timbral sound module can play several timbres (sounds) on different 
channels simultaneously.    A multi-timbral device is one that is prepared to sound like more than one 
instrument at a time.

Mute:    A sequencer command to disable the playback of specified tracks.

Patch:    In some early keyboard synthesizers, one selected "instruments" to play (e.g., vibraphone, 
clarinet...)    Later, the term "voice" emerged, in part, because some of the sounds were beyond 
instruments (police whistles, human voices, etc.).    In contemporary MIDI-computing, the word "patch" is 
prominent--one reason being that a single keyboard setting, like 99, may encompass a large range of 
percussive sounds.    In any event, to a sequencer, the patch setting will determine the nature of the 
sounds.

Piano Roll Editor:    A common notation used for editing by many sequencers.    The notes of each track 
are shown as horizontal bars: the vertical position representing pitch; the horizontal length representing 
duration of the note (or chord).

Pitch Bend Wheel:    A wheel on a keyboard that allows notes to be bent up or down.    "Pitch bend" is 
also a MIDI message.

Polyphony:    From the Greek, meaning variety of tones.    In MIDI, the question is:    "How many notes 
can be played simultaneously?"      Maximum polyphony cannot be exceeded.

PPQN:    Pulses per quarter-note.    A measurement of time resolution.    Similar to the term Timebase.

Program Change:    A MIDI event used to select a new program or patch.

Quantization:    To quantize is to force all notes played to fall on the nearest time interval specified.    It 
shifts events to an exact rhythmic position.



Record:    In the world of sound, to register something reproducible on a disk, like a phonograph record, 
or on magnetic tape.    Traditional recording captures the amplitude (height) and frequency (number) of 
wave forms.    MIDI-computing does not really "record."    It encodes messages, digitally, by means of 
numbers.    Because of established usage, however, the words "record" and "recording" often appear in 
MIDI-computing, along with "play," "rewind," "fast forward," etc.    In MIDI-computing, these words are 
really metaphors.    A typical sequencer will "record" all of the MIDI events received, along with the time 
they were received.

Standard Midi File:    Often identified by its extension (.MID, .MFF or .SMF), this is a file that can store 
MIDI messages, such as songs.    The data in a MIDI file can be played, manipulated, edited...    A MIDI 
file comprises actions performed on an instrument (keys pressed, how hard...)    There is a standard MIDI 
file format.    A principal advantage of a MIDI file is that it uses comparatively little disk space, but, more 
importantly, it is a standard across platforms and sequencers.

Status Byte:    In a MIDI message, this announces what kind of message is being sent, e.g., "note-on."

Synthesizer:    (Often shortened to synth.)    A device which is capable of producing synthetic sounds.    
Originally, a synthesizer was so called because it synthesized acoustic instruments.    Nowdays, the term 
refers to the sound-generating circuitry of any MIDI gear.    Another term is sound module.

Tempo:    In music, the rate of speed (like allegretto).

Time Base:    The number of ticks per beat.

Time Signature:    In traditional musical notation, this is expressed as a fractional sign, like 3/4.    The 
denominator indicates the unit for the beat; the numerator shows the number of notes per measure.

Track:    In MIDI, the term "track" designates a location where one records or plays back a musical 
message, usually a portion of the total arrangement.    To illustrate, one might record an oboe melody line 
on Track Two, then record a bowed bass line on Track Three.    When played, the sounds can be 
simultaneous.    Most MIDI software now accommodates 64 tracks of music, enough for a rich orchestral 
sound.    Tracks are purely for convenience; channels are required.

Transpose:    To perform a musical composition in a different key.    Both synthesizers and sequencers 
can carry out this function.

Velocity:    Velocity is the MIDI way of determining how hard a note is pressed on the keyboard controller.


